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Are you tired of your words blending into the background, longing for a touch of style and emphasis? Well, fret no more! In this handy guide, we will explore the fascinating world of adding lines on either side of a word, ensuring your text stands out with flair. Whether youre using Microsoft Word, Open Office, or any other word processing software,
weve got you covered.You might be wondering, how do I turn a dash into a snazzy line that effortlessly embraces a word? Or perhaps youre curious about inserting a solid line to really make an impact. Well, fear not, for we will demystify the process step by step. By the end of this blog post, youll be equipped with the knowledge and skills to add lines
like a pro.If you are ready to take your word formatting game to the next level and sprinkle some visual magic into your documents, lets dive in and uncover the secrets of creating lines on either side of a word.How to Add Stylish Lines on Either Side of a WordIf youve ever wondered how to make a word stand out and give it that extra pizzazz, look no
further! Adding lines on either side of a word is a fun and creative way to draw attention to it. In this guide, well show you how to accomplish this nifty trick in just a few simple steps. Lets dive right in!The Basics: Using HTML TagsTo achieve the desired effect, well utilize HTML tags in conjunction with the CSS border property. By wrapping your
desired word within a tag, you can easily apply the border styling to it. Heres an example:htmlYourWordThis basic code adds a simple line on both the top and bottom of the word YourWord. But fear not, my curious friend, we can take this concept even further!Experimenting with StylesNow that you understand the foundation, its time to get creative
with different line styles and effects. Lets explore some options:Dashed Excitementlf youre feeling adventurous, try adding dashed lines to your word. Its like adding a touch of excitement and suspense!htmlYourWordNow, every time someone reads your content, they wont be able to contain their anticipation, eagerly awaiting the revelation of your
special word.Double TroubleFor those wanting to make an even bolder statement, consider doubling up on those lines. Your word will command attention like never before!htmlYourWordlts like having two bouncers on either side of your word, making sure it stands out from the crowd.Groovy Gradientlf youre in the mood for something extra stylish,
why not add a gradient effect to those lines? Its like giving your word a fashionable makeover!htmlYourWordWith this vibrant technique, your word will radiate charisma, attracting all eyes to its magnificent presence!Take It Up a NotchNow that youve mastered the art of adding lines on either side of a word, theres no limit to your creativity! Feel
free to experiment with different colors, line thicknesses, and even animating those lines for some extra flair. Let your imagination run wild, and watch as your words come to life on the screen.Remember, the key is to have fun with it. So go ahead, embrace your inner word artist, and let those lines shine!Thats all for now, my fellow word enthusiasts.
Until next time, may your lines be stylish, your words be bold, and your creativity know no bounds!FAQ: How do you put lines on either side of a word?How do I insert a horizontal line between words in WordIf you want to add a horizontal line between words in Microsoft Word, youre in luck! Its a straightforward process. Simply follow these
steps:Place your cursor where you want to insert the line.Press the hyphen key on your keyboard three times consecutively and hit the Enter key.And voila! You now have a horizontal line between your words.How do you put lines on either side of a wordTo put lines on either side of a word in Word, theres a nifty trick you can use. Heres what you
need to do:Type your word in Word.Highlight the word.Press Ctrl + D to open the Font dialog box.In the Effects section, select the Double Strikethrough option.Click on OK to apply the changes.Now your word will be surrounded by lines on both sides, giving it a striking appearance.How do I turn a dash into a lineTurning a dash into a line can be
easily done in Word. Just follow these simple steps:Type a single hyphen - in your Word document.Hit the spacebar once to convert the hyphen into a dash.Press the spacebar again, followed by another hyphen.And just like that, your dash has transformed into a line! Its as easy as dash-space-space-hyphen.How do you make a dash with a solid line in
WordIf you prefer a solid line instead of a dash in Word, its a breeze to achieve. Heres how you can do it:Type two hyphens in your Word document.Hit the spacebar once to convert the hyphens into a dash.Press the spacebar again and type two more hyphens.Now you have a solid line created with four hyphens. Its a neat trick to give your document
a bit of visual flair.How do I add a signature line in Open OfficeTo add a signature line in Open Office, you can follow these simple steps:Place your cursor where you want to insert the signature line.Click on the Insert menu at the top of the Open Office window.Select Horizontal Line from the dropdown menu.A line will be inserted, but it may not look
like a signature line immediately.Right-click on the line and choose Line Style from the context menu.In the Line Style dialog box, select the Signatures category.Choose the style of the signature line that you prefer and click OK.Now you have a signature line in your Open Office document, perfect for adding a touch of professionalism.How do you add
a top border in WordTo add a top border in Word, you can use the following steps:Place your cursor at the beginning of the paragraph where you want to add the top border.Go to the Home tab in Word.In the Paragraph section, click on the small arrow in the bottom right corner.In the Borders and Shading dialog box that opens, select the Borders
tab.Choose the top border style you desire from the options available.Customize the color, line style, and thickness if needed.Once youre satisfied with your selection, click OK.Now your paragraph has a stylish top border, making it stand out from the rest of the text.How do I get rid of lines in my Word documentAre unwanted lines cluttering up your
Word document? No worries! You can remove them with ease:Select the line or lines you want to delete.Press the Delete key on your keyboard.Poof! The lines are now gone.Its as simple as that. Say goodbye to unsightly lines in your Word document!How do you insert a solid line in WordTo insert a solid line in Word, you need to follow these
steps:Place your cursor where you want to insert the solid line.Go to the Insert tab in Word.In the Illustrations section, click on Shapes.From the dropdown menu, choose the line shape you prefer.Click and drag on your document to draw the line.Customize the lines color, thickness, and style as desired.Once youre satisfied with the appearance,
release the mouse button.Now you have a solid line in your Word document, ready to divide sections or add visual separation.How do you insert lines in Microsoft WordInserting lines in Microsoft Word is a breeze. Heres how you can do it:Place your cursor where you want to insert the line.Go to the Home tab in Word.In the Paragraph section, click
on the Borders option.From the dropdown menu, select Horizontal Line.A line will be inserted at your cursors location, spanning the width of the page.Now you have a line in your Word document, effortlessly added to enhance readability or separate content.Now that you know your way around lines in Word, you can add a touch of flair and
organization to your documents! Whether its adding horizontal lines between words, creating signature lines, or inserting solid lines, Word has got you covered. Happy line-making! Microsoft's flagship word processor has tons of neat little features to customize your documents, and it can be hard to keep track of and master them all. But with our
quick guides to using Microsoft Word, we can help you learn how to use the tools you'll need to get up and running and make the most out of it. If you want to learn how to insert a line in a Word document, you've come to the right place. In this guide, we'll show you how to insert a line in Word. Using a few different methods, you can choose the one
that augments your workflow in Microsoft Word the best.How to draw a line in Word using the Shapes menulf youd like your line to be a particular length, you can draw it in Word using an option in the Shapes menu. Step 1: Open your Word document or create a new one. Step 2: Go to the Insert tab and select Shapes. Digital Trends Step 3: Within
the section labeled Lines, choose your preferred line style. Digital Trends Step 4: Move your mouse pointer to where you want to insert your line, and click and hold it as you drag it across the page to the desired endpoint of your line. Then release your hold. Digital Trends How to insert a line in Word using the keyboard AutoFormatMaybe you prefer
to tackle tasks in Word using keyboard shortcuts. If so, you can insert a line using the keyboard AutoFormat feature. Step 1: Open your Word document or create a new one. Step 2: In the document, put your cursor where you want to insert the line. Then press the Hyphen key on your keyboard three times. (This key should be located in between the
zero key and the plus/equal sign key.) Then press the Enter key. Step 3: A line that stretches between both ends of the width of the page (minus the margins) should automatically appear. If you want to type on the line or insert a signature, simply move your cursor above the line to add your text. Digital Trends Step 4: You can customize the style of
your inserted line by choosing a different keyboard key to press three times. For example, pressing the Plus/Equal Sign key three times and then Enter will produce a set of two parallel lines. Here are some other options: Three asterisk key presses: Produces a line of square dots.Three underscore key presses: Produces a bold line.Three number sign
key presses: Produces a group of three lines (one bold with two thin).Three tilde key presses: Produces a zig-zag line. Note: The above bulleted line styles will require using the Shift key plus the key listed and then Enter in order to work. Digital Trends How to insert a line in Word using the Borders menulf you want a simple horizontal line that
stretches from the left to the right margin, you can use an option in the Borders menu. Step 1: Open your Word document or create a new one. Step 2: Place your cursor where you want the line. Step 3: Go to the Home tab, open the Borders menu, and choose Horizontal Line. Digital Trends FAQsHow do you insert a line through a word? You can
easily apply whats called strikethrough formatting to a word, sentence, or paragraph in Word. Select the text, go to the Home tab, and choose Strikethrough in the Font section of the ribbon. How do I put a line around a word in Word? With the Borders menu in Word, you can add a line around a word or other text. Select the text, go to the Home tab,
and open the Borders menu. Pick the Outside Borders option to place a line around the entire text. How do I insert a horizontal line in Docs? If you use Google Docs instead of Microsoft Word, you can insert a horizontal line easily in that application as well. Open your Google Doc and place your cursor where you want the line. Select the Insert tab and
pick Horizontal line. Anita George has been writing for Digital Trends' Computing section since 2018. So for almost six years, Anita has written Microsoft has announced that support for Microsoft 365 apps on Windows 10 will end this year on October 14, as reported by The Verge. This is also the end-of-support date for Windows 10 as a whole, but
the move is still a little surprising considering that Microsoft is now offering the Windows 10 Extended Security Updates (ESU) Program.Anyone who joins this program for $30 can continue to safely use Windows 10 for a whole extra year -- so you might think that Microsoft would let them continue to use the Office apps too. That said, it's not like the
apps will disappear, they just won't receive any more updates. According to Microsoft, this could cause "performance and reliability issues over time" but whether these issues will pop up within the ESU program's duration or not is anyone's guess. Read more Microsoft will begin offering access to Al agents specialized generative models that can
operate independently and automate repetitive daily tasks to enterprise users. The new program is called Microsoft 365 Copilot Chat and offers "pay-as-you-go agents to our existing free chat experience for Microsoft 365 commercial customers," the company announced Wednesday.The "free plus metered agent usage" Microsoft 365 Copilot Chat
offers many of the same features as the existing $30 per user per month "Microsoft 365 Copilot" enterprise program, including access to a chatbot powered by GPT-40, Copilot Pages, file uploads, image and code generation, enterprise data protection, and, of course, to Copilot Studio, where individual users and IT departments alike can create Al
agents. Note, however, that the free Chat program does not grant you access to the Copilot personal assistant, which integrates the Al's capabilities into the rest of the 365 Copilot app ecosystem such as Word, Outlook, and Excel. Read more Microsoft has announced that neural rendering capabilities are coming to DirectX soon. Cooperative vector
support, as it's called, will lead to "cross-platform enablement of neural rendering techniques," according to Microsoft, and it will usher in "a new paradigm in 3D graphics programming."It sounds buzzy, but that's not without reason. This past week, Nvidia announced its new range of RTX 50-series graphics cards, and along with them, it revealed a
slate of neural rendering features. Neural shaders, as Nvidia calls them, allow developers to execute small neural networks from shader code, running them on the dedicated Al hardware available on Nvidia, AMD, Intel, and Qualcomm GPUs. Microsoft is saying that it will enable these features on all GPUs, not just those sold by Nvidia, through the
DirectX API. Read more Download Article Draw or type lines in Microsoft Word Download Article Do you want to create a horizontal line in your Microsoft Word document? You can use the Shape tool, Borders tool, or a keyboard shortcut to add a line in Word. Lines can be used to separate text or provide a blank space for sign-in sheets. Here's how to
insert a line in Word using your Windows, Mac, iPhone, or Android device. To insert a Line in Word, select the Shapes icon on the Insert tab. Select a line type, and then click and drag your cursor to draw the line. Alternatively, type three dashes (---) and hit Enter to add a line with AutoFormat. 1Click the Insert tab. This tab is in the blue ribbon at the
top of the Word window, between Home and Draw. 2Click Shapes. It's in the Insert toolbar, next to the icon of an overlapping circle and square.A drop-down menu will appear. Advertisement 3Select a line shape. In the Lines heading, click one of the line templates. You can choose a line, line arrow, double line arrow, and more.4Draw your line. Click
and drag across the document to create your line.If you need to adjust the line's length and orientation, select the line. Click the left or right circle. Drag it left or right to adjust the length, or drag it up and down to adjust the orientation.To move the line, click and drag it to the desired position. Advertisement 1Click the Home tab. This tab is in the
blue ribbon at the top of the Word window, between File and Insert.You may already be on this tab by default.2Click the "Borders" arrow. This is next to the icon of the dotted square with a solid bottom line.A drop-down menu will open.3Click Horizontal Line. This will be towards the bottom, above Draw Table.A horizontal line will be added.4Format
your line. Double-click the line; a dialogue box will appear.To change the line thickness, use the up and down arrow below Height. The higher the number, the thicker the line will be.To change the color, click the color box underneath Color. Select your desired color.Click OK to save and apply your changes.To move the line, double-click and drag it to
the desired position. Advertisement 1Place your cursor where you want your line to appear. You'll need to be on a blank line, as this won't work if there is text before or after your cursor on the same line.You'll be creating a horizontal line that spans from one edge of your page to the other. The line will stop at your set margins.If you want to make the
line span the whole page, you'll need to change your document margins.2Type three dashes in a row. Use your dash key on the number row at the top of your keyboard, or on the numeric pad.3Press Enter to convert the dashes into a line. AutoCorrect will automatically create a solid line that will situate itself directly beneath the previous line of
text.Note that the line does not occupy the space of a line of text, but instead exists between lines of text.4If you don't have AutoCorrect enabled, do the following:Click File.Click Options.Click Proofing.Click AutoCorrect Options.Click the AutoFormat As You Type tab.Check the box for Border lines.Click OK.If you want to turn off AutoCorrect, uncheck
the boxes.5Use different characters for different line styles. There are a variety of different lines that you can create by using characters other than the dash:[1]Thin line: Three hyphens (-).Thick line: Three underscores (_).Double line: Three equal signs (=).Dotted line: Three asterisk (*¥).Triple line: Three pound signs (#).Squiggly line: Three tildes
(~).6Move the line by entering text above it. You can prompt the line to move down by typing text above it and then pressing Enter.Deleting text above the line will prompt it to move upward. Advertisement 10pen a document in the Microsoft Word app. This looks like a blue notebook next to a W.Microsoft Word is available for iOS in the App Store
and for Android in the Google Play Store.Tap Blank document to open a new document or tap a file to open an existing document.2Tap . This can be found above the keyboard, to the right. On Android, this may look like an arrow.If you don't see your keyboard, tap the document to bring it up.A new menu will open.3Tap Home. This will be to the left of
the formatting window.A drop-down menu will open.4Tap Insert. You'll see a list of all objects you can insert.5Tap Shapes. This is next to the icon of an overlapping circle and square.6Select a line shape. In the "Lines" heading, tap one of the line templates. You can choose a line, line arrow, double line arrow, and more.7Draw your line. Tap and drag
across the document to create your line.Use two fingers to pinch and zoom out to view the entire document.If you need to adjust the line's length and orientation, tap the left or right circle. Drag it left or right to adjust the length, or drag it up and down to adjust the orientation.To move the line, tap and drag it to the desired position. Advertisement
Add New Question Question How do I view all available symbols in Microsoft Word? Click "Insert" and then click "Symbols" and you should be shown a box with all of the symbols in it. Question How do I add a line on the first page, and no lines on the second? Click "Insert" and then click "Symbols" and you should be shown a box with all of the
symbols in it. Question How do I change the color of the line? In the paragraph section, open the drop-down menu on the "Borders" button. At the very bottom is a "Borders and Shading" option. In that option, change the color of the bottom border to your specified color. Click the "Borders" button. See more answers Ask a Question Advertisement
Written by: wikiHow Technology Writer This article was co-authored by wikiHow staff writer, Rain Kengly. Rain is a tech writer and editor for wikiHow with over 5 years of professional writing experience. In the past, Rain has worked with other creative writers as a Writing Tutor at San Francisco State University and has published gaming features,
guides, and news articles for a variety of media outlets. Rain shares a lifelong passion for writing and gaming and is eager to grow alongside new tech inventions. This article has been viewed 2,199,998 times. Co-authors: 12 Updated: May 2, 2025 Views:2,199,998 Categories: Microsoft Word PrintSend fan mail to authors Thanks to all authors for
creating a page that has been read 2,199,998 times.
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